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فصل چهارم

گرافیک در رایانه

استفاده از گرافیک در القای یک مفهوم یا اندیشه از دیر باز سابقه دارد و هر چه مناسب تر از آن استفاده شود، 
نتایج ایجاد شده مقبول تر و مؤثرتر است. امروزه نرم افزارهای متعدد با امکانات مختلف در حوزة گرافیک ایجاد 
شده است. در این فصل در دو واحد يادگيري کار با ابزارهای ساده گرافیکی و کار با ابزارهای پیشرفته گرافیکی 

و در 15 کارگاه  با مقدمات کار با نرم افزار ایلاستریتور و برخی از امکانات آن، آشنا می شوید.
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واحد یادگیری 7 

شایستگی  كار با ابزارهاي ساده گرافيكي

آیا تا به حال پی برده اید

• نرم افزارهای‌‌‌‌‌‌‌‌‌‌‌ گرافیکی در چه اموري کاربرد دارند؟

• تنظیمات کاغذ برای چاپ چگونه است؟

• تصاویر نقش بیتی و برداری چه ویژگی هایی دارند؟

هدف از این واحد شایستگی، چگونگي كار با ابزارهای  اولیه نرم افزار Illustrator است. 

 استاندارد    عملکرد

با استفاده از دانش و شناخت محيط نرم افزار گرافیکی و چگونگي عملكرد آن، فایل گرافیکی چاپی ایجاد کرده و با 
استفاده از ابزارهای ترسیمی تصویرسازی و فضاسازی کند. فایل را با قالب مناسب ذخیره کند و با گرفتن خروجی 

مناسب آنها را در سایر پروژه ها بکار گیرد.
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تعریف گرافیک 

گرافیک، هنر ارتباط تصویر با مخاطب است. این هنر با استفاده از نقطه، خط، شکل و رنگ در کوتاه ترین زمان بیشترین 
پیام را به مخاطب مي دهد. هنر گرافیک، هنری بسیار گسترده است و در تمام زوایای دید ما به چشم می‌خورد. از 
بسته بندی محصولات تا پوسترهای تبلیغاتی و از سربرگ و کارت ویزیت و فاکتور تا آرم و نشانه، از طراحی صحنه و لباس 
تا تیتراژ و جلوه های ویژه فیلم و از تبلیغات تجاری و تیزرهای تلویزیونی تا نقاشی‌های متحرک، همه و همه با گرافكي 

آميخته شده‌اند.

شکل7ـ١                       شکل 7ـ٢                        

فعاليت 
كارگاهي

فعاليت 
كارگاهي

دو تصوير را با هم مقايسه کرده و تفاوت این دو را نسبت به یکدیگر بنويسيد.

پیامی که از تک درخت شکل 7ـ2 دریافت می کنید، بنویسید.
از کدام یک از وسیله هایی  که در كارگاه  مشاهده می‌کنید یا به 

همراه دارید، پیام گرافیکی دریافت می‌کنید؟

..........................................................................................................................................................................................

ارتباط گرافكي و نرم افزار
در عصر حاضر از انواع نرم افزارها برای کارهای روزمره استفاده می‌شود که قسمتی از این نرم افزارها در اختیار طراحان 

گرافیک قرار گرفته است.
همراه با رشد جمعیت و نوآوری‌های جدید در عرصه علم و صنعت، نیاز به تبلیغات، روز به روز افزایش یافته است و 
با وجود ظهور تکنولوژی و نرم افزارهای جدید گرافیکی،  قابلیت‌های متعددی در این زمینه به وجود آمده است.امروزه 
طراحان گرافیک با استفاده از نرم افزارهای گرافیکی آثار خود را از طراحی تا چاپ به نتیجه مطلوب می رسانند.  به طور کلی 
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شکل 7ـ4ـ پیکسل‌های تشکیل‌دهنده شکل 7ـ3 
به شکل مکعب‌های کوچکی قابل مشاهده‌اند.                    

شکل 7ـ3                      

  Illustrator 5  ـ تصویر برداری ترسیم شده در نرم افزار   شکل 7
که بخشی از آن به میزان قابل توجهی بزرگ شده است.

)Vector( برداری
در این فرمت تصاویر گرافیکی به صورت برداری تعریف 
می شوند به این معنی که نقطه با مختصات )X, Y( و 
تعریف می‌شود. همینطور  نقطه  دو  از  استفاده  با  خط 
این  به  هم   ... و  ضخامت  رنگ،  به  مربوط  اطلاعات 
اطلاعات ریاضی اضافه می‌شود. شما هر چه تصاویر را 
بزرگ کنید تصاویر پیکسل پیکسل نمی‌شوند چون با 
هر بزرگ‌نمایی دوباره تصاویر با کمک اطلاعات ریاضی 
نمایش‌ها  صفحه  محدودیت  اگر  و  می‌شوند  بازسازی 
اجازه می داد این تصاویر تا بی نهایت قابل بزرگ‌نمایی 

بودند، زیرا به پیکسل‌ها وابسته نیستند. 

نرم افزارهای گرافیکی از دو خصوصیت برداری و نقش بیتی پیروی می کنند و شرکت‌های سازنده این نرم افزارها در پی 
رقابت با یکدیگر نرم افزارهایی با هر دو خصوصیت را به وجود آورده اند که طراحان باید با ویژگی هر یک از اینها آشنا شوند.

) Bitmap( نقش بیتی
تمامی عکس‌ها با هر فرمتی نقش بیتی هستند. خصوصیت مشترک این عکس‌ها در این است که از ترکیب یک سری 
اطلاعات پیکسل به پیکسل تهیه شده‌اند. داده ها در قالب بایت‌های اطلاعاتی شامل اطلاعاتی مثل رنگ و موقعیت پیکسل 
در چهارچوب عکس هستند. خروجی نرم‌افزارهای رایج گرافیکی مثل فتوشاپ همیشه پیکسلی هستند و با بزرگ کردن 
تصاویر عکس ها شفافیت خود را از دست می‌دهند و در کناره های تصویر، پدیده شکستگی در لبه‌ها اتفاق می‌افتد. حجم 
این پرونده ها بزرگ است و فضای بیشتری را اشغال می کنند. وقتی عکسی را اسکن می‌کنید پرونده حاصل فرمت نقش 

بیتی دارد. 
پیکسل را در تصاویر دیجیتالی، کوچک‌ترین بخش تصویر می‌گویند و در مباحث مربوط به گرافیک نقطه ‌را  کوچک‌ترین 

عنصر تشکیل دهندۀ تصویر  می‌خوانند.
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فعاليت 
در جدول زیرمشخصات تصاویر برداری و نقش بیتی را بنویسید.كارگاهي

جدول مشخصات تصاویربرداری و نقش بیتی

 VectorBitmap

جاهای خالی این پازل را که با نرم افزارهای گرافیکی انجام شده اند، پرکنید. فعاليت منزل

بسته بندی محصولات

گرافیک محیطی

لوگو

جلوه های ویژه، فیلم محمد رسول الله
طراحی صنعتی
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فعاليت 
 نام نرم افزارهای گرافیک  دو بعدی و سه بعدی را در جدول زیر بنویسید.كارگاهي

فیلم را مشاهده کرده و فعالیت زیر را انجام دهید.

نرم افزارهای گرافیکی

سه بعدی دو بعدی 

نرم افزارهای‌‌‌‌‌‌‌‌‌‌‌ گرافیکی  در چه  اموري کاربرد دارند؟ پژوهش

 شرایط عملکردمراحل کار
)ابزار،مواد، تجهیزات، زمان، مکان و ...(

نمرهاستاندارد )شاخص ها/داوری/نمره دهی(نتایج ممکن

شایستگی‌های غیرفنی
)N73( درستکاری و کسب حلال )N41(انتخاب فناوری های مناسب
 )N53( ـ نقش در تیم )N14( ـ تفكر خلاق )N12( تصميم گيري

توجه به همه مواردقابل قبولکارآفرینی )N81( ـ زبان انگلیسی

2

دانش ارگونومكي )خود فرد( ـ كنترل حفاظتي الكتركيي و الكترونكيي ایمنی و بهداشت
)ابزار و تجهيزات(

ایجاد اسناد الکترونیکی کاهش مصرف کاغذتوجهات زیست محیطی
توجه به ایمنی و بهداشتغیر قابل قبول

1

کاربرد مثال ها و فعالیت هایی در حوزه های اخلاقی، عرفی، دینی و نگرش
اجتماعی در محتوای درسی ـ امنيت ابزارها و وسايل

شناسایی تصاویربرداری و 
نقش بیتی و نوع نرم افزار 

گرافیکی 

مکان : کارگاه استاندارد رایانه
تجهيزات: رایانه ـ سیستم عامل ـ نرم افزار گرافیکی

زمان: 5 دقیقه

3بالاتر از حد انتظار

تشخیص تصاویربرداری و نقش بیتی، قابل قبول
تشخیص نوع نرم افزار گرافیکی

2

عدم توانایی در تشخیص تصاویر برداری و غیر قابل قبول
نقش بیتی ـ تشخیص نوع نرم افزار گرافیکی

1

ارزشیابی تکوینی مرحله 1

فیلم شماره 10149 : انواع نرم افزارهای گرافیکی فیلم
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Adobe Illustrator   معرفی نرم افزار
طراحی‌های  برای  که  قدرتمند  نرم افزارهای  از  یکی 
حجم  است.   Adobe Illustrator شده،  ارائه  برداری 
پایین و کیفیت بالا، مهم ترین خصوصیت این نرم افزار 

گرافكيی برداری است.

  Illustrator كارگاه 1      شروع کار با نرم افزار 

1 نرم افزار Illustrator  را اجرا كنيد.
در هنگام بارگذاري برنامه، شــكل7ـ6 ظاهر مي شود. اين شكل بسته 

به نسخۀ نرم افزار متفاوت خواهد بود.

شکل 7ـ6                         

 نسخه نرم افزار نصب شده روي رايانۀ كارگاه را بخوانيد.  

2 برای نمایش یک پنل از منوی Window روی نام پنل مربوطه 
کلیک کنید.

در قسمت راست پنجره اصلی برنامه، به طور پیش فرض پنجره های کوچکی 
وجود دارند که بر روی سایر پنجره‌ها باز می‌شود. به این پنجره‌های کوچک 
پنل یا پالت می گویند. پنل ها برای مدیریت عملیات در حین انجام برنامه 

به کمک کاربر می‌آیند.

فعاليت 
كارگاهي

نوارها و پنل های موجود در صفحه را بررسی کنید و به کمک هنرآموز خود، عنوان هر یک از بخش‌های 
تعیین شده را درکادر مربوطه بنویسید.‌

شکل 7ـ7ـ محیط نرم افزار

فعاليت 
كارگاهي
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شکل 7ـ 8ـ ایجاد سند جدید

3 با توجه به مسیر نشان داده شده در شکل 7ـ 8، 
یک سند جدید ایجاد کنید.

با توجه به شكل 7ـ 8 کلید میانبر گزینه New را بنویسید. كنجكاوي

4 در کادر محاوره ای بازشده در قسمت Profile سند جاری،گزینه Print را انتخاب و پیش تنظیمات 
برای انجام عملیات چاپی را بررسی کرده و نام هریک از بخش های نشان داده شده را در کادر مربوطه 

بنویسید. )شکل 7ـ9( 

New Documet 9 ـ کادر محاوره ای   شکل 7

كنجكاوي اندازه کاغذ A4، در پیش تنظیمات Print را بنویسید.

در ایران واحد اندازه گیری )Unit( سندهای چاپی mm و cm انتخاب می‌شود. ولی واحد اندازه‌گیری سندهای وبی 
که برای صفحات اینترنتی و نمایشی مناسب هستند، بر اساس واحد pixel است.

فعاليت 
كارگاهي

 یک سند جدید  در اندازه A4 برای انجام عملیات چاپی و با واحد cm باز کنید.

New
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آنچه آموختم:

................................................................................................................................................................................................ .1

................................................................................................................................................................................................ .2

................................................................................................................................................................................................ .3

برداشت

 شرایط عملکردمرا حل کار
)ابزار،مواد، تجهیزات، زمان، 

مکان و ...(

نمرهاستاندارد )شاخص ها/داوری/نمره دهی(نتایج ممکن

ورود به نرم افزار 
گرافیکی و 

آماده سازی سند

مكان: كارگاه استاندارد 
رایانه

تجهيزات: رایانه ـ سیستم 
عامل ـ نرم افزار گرافیکی 

زمان: ٨ دقیقه

3بالاتر از حد انتظار

قابل قبول
تشخیص بخش های مختلف پنجره نرم افزارـ انجام عملیات با پنل ها، جعبه ابزار و منوی 

دستورات ـ ایجاد فایل گرافیکی چاپی با تنظیمات مناسب ـ ذخیره با فرمت پیش فرض ـ 
بازیابی اسناد

2

عدم توانایی در تشخیص بخش های مختلف پنجره نرم افزارـ انجام عملیات با پنل ها، غیر قابل قبول
جعبه ابزار و منوی دستورات ـ عدم توانایی در ایجاد فایل گرافیکی چاپی با تنظیمات 

مناسب ـ ذخیره با فرمت پیش فرض ـ بازیابی اسناد از مسیر تعیین شده

1

ارزشیابی تکوینی مرحله 2

مسیرها به مجموعه‌ای از نقاط مرتبط به هم گفته می‌شود که هریک، قابلیت ویرایش و تغییر دارند. اين نقاط سبب 
انعطاف مسير شده و به طراح، اجازه‌ تغيير شكل مي‌دهد. به اين نقاط  Anchor points یا نقاط لنگری گفته مي‌شود.

Anchor point

   Pencil كارگاه 2     ترسیم با ابزار 

0ـ1(.  در اين كارگاه قصد داریم روش ترسیم این تصویر را آموزش دهیم )شکل 7

1 یک سند جدید در اندازه A4 بازکنید.

2 ابزار Pencil را انتخاب کنید )شکل 7ـ11(.
با انتخاب این ابزار و کشیدن ماوس بر محل ترسیم، می توان اقدام به 

شکل 7ـ10ترسیم شکل مورد نظر نمود. 
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 Pencil شکل 7ـ11ـ ابزار

شکل 7ـ12ـ پنل رنگ

3 رنگ مداد را انتخاب کنید. )شکل 7ـ12(
معمولاً دو بخش در هر ترسیم مشاهده می‌شود. Fill یا بخش پرکننده 
و Stroke یا خط دور. مســیر، خط دور قابل مشاهده یک شیء است. 
 Stroke و Fill در بخــش پایین جعبه ابزار، دو مربع برای تنظیم رنگ
قرار دارد. بر روی مربع دابل کلیک کرده ســپس از پنل باز شده رنگ 

دلخواه را انتخاب کنید.

نام مربعی را که  برای تنظیم رنگ خط محیطی است بنویسید. كنجكاوي

اگر انتخاب در حالت None  باشد، خطوط محیطی درصفحه دیده نمی شوند. یادداشت

4 با استفاده از ابزار مداد و به کمک هنرآموز خود، مراحل زیر را به ترتیب اجرا کنید.

1 2

4 6

3

5

شکل 7ـ13
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ذخیره سند با پسوند پیش فرض نرم افزار Illustrator یعنی Ai صورت خواهد گرفت. این فرمت فقط 
با Illustrator قابل خواندن است.

یادداشت

5 ضخامت خطوط را تغییر دهید.
Selection برای تغییر ضخامت خطوط، ابتدا خط مورد نظر را با ابزار

انتخاب کرده و سپس عدد موردنظر را طبق شکل 7ـ14 وارد کنید.
 برای زیبایی تصویر، ضخامت خط‌های ترسیم شده را اعداد متفاوت، انتخاب کنید.

6  با توجه به مسیر نشان داده شده در 
را  خطوط  شکل  و  ضخامت   15   7 شکل 

تغییر دهید.

فرمت  با    File/Save مسیر  از  را  سند    7
پیش فرض نرم افزار ذخیره کنید.

شکل 7ـ14ـ تغییر ضخامت خطوط

شکل 7ـ15ـ تغییر شکل خطوط

آنچه آموختم:

................................................................................................................................................................................................ .1

................................................................................................................................................................................................ .2

................................................................................................................................................................................................ .3

برداشت
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 Pen كارگاه 3     ترسیم با ابزار 

یکی از ابزارهای ترسیمی نرم افزار Pen Tool  است که مهم ترین کاربرد آن، ترسیم اشکال توسط  مسیرها است.

در اين كارگاه قصد داریم شكل 7ـ16 را ترسیم کنیم.
1 یک سندجدید در اندازه pixel 400 ×600  بازکنید.

2  ابزار شکل ٧ـ١٧ را انتخاب کنید.

با توجه به شكل 7ـ17 کلید میانبر ابزار Pen را بنویسید.  كنجكاوي
PEN

قبل از ترسیم تصویر داده شده، این مراحل را انجام دهید.	

تا  کنید  کلیک  روی صفحه  بر  موردنظر  نقطه  در  1ـ 
ابتدای مسیر ایجاد شود. 

این  نیز کلیک کنید در  نقطه 2،  ادامه در  اگر در  ٢ـ 
حالت، نرم افزار نقاط 1 و 2 را توسط یک پاره خط به 

یکدیگر متصل می کند.

شروع1

2
اگر به جای کلیک، از کلیک و کشیدن ماوس اســتفاده کنید نقطه منحنی همراه با دستگیره ایجاد 

می‌شود که اگر نقطه دوم را کلیک کنید، یک خط منحنی ترسیم می‌شود.
یادداشت

شکل 7ـ16 Pen شکل 7ـ17ـ ابزار
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در حین کار با ابزارها، با فشردن کلید ترکیبی Ctrl+Z یک مرحله به عقب برمی گردید.

 چنانچه در هنگام ترسیم خطوط با ابزار  Pen  کلید  Alt  را پایین نگه دارید یک مسیر بسته ایجاد 
خواهد شد.

 None در هنگام ترسیم با خطوط محیطی باید در حالت Fill ابزار
باشد.

یادداشت

یادداشت

3 پس ازآشنایی و تمرین با ابزار Pen، برای ترسیم 
نوک پنگوئن، از نقطه 1 به 2، یک خط منحنی ترسیم 

کرده تا نوک کامل شود.

کردن،  اضافه  برای  مسیرها  ترسیم  هنگام  در   4  
 Pen ابزار  روی  بر  یکدیگر  به  نقاط  تغییر  یا  حذف 
ماوس،  دکمه  داشتن  نگه  پایین  با  و  کرده  کلیک 
ابزارهای زیرمجموعه آن را باز کنید )شکل 7ـ17(.

با فعال کردن آیتم های  Add,Delete در ابزار Pen چه تغییراتی می توان روی مسیر ایجاد کرد؟ كنجكاوي

5 با انتخاب ابزار  Add Anchor Point و کلیک بر 
روی نقطه موجود بر مسیر ترسیم شده، دو دستگیره 
این  دادن  تغییرجهت  با  می‌توانید  که  می‌شود  ایجاد 

دستگیره‌ها، خطوط ترسیم شده را تغییر فرم دهید.
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5 پس از اتمام ترسیم، سند را ذخیره کنید.

آنچه آموختم:

................................................................................................................................................................................................. .1

.................................................................................................................................................................................................    .2

................................................................................................................................................................................................. .3

برداشت

4 به کمک هنرآموز خود، مراحل را ادامه دهید.

 شرایط عملکردمرا حل کار
)ابزار،مواد، تجهیزات، زمان، مکان و ...(

نمرهاستاندارد )شاخص ها/داوری/نمره دهی(نتایج ممکن

تصویرسازی  
با استفاده از 

ابزارهای ترسیمی

مكان: کارگاه استاندارد رايانه
تجهيزات: رایانه ـ سیستم 
عامل ـ نرم افزار گرافیکی

زمان: 30 دقیقه

3بالاتر از انتظار

2ترسیم مسیر با ابزار Pen و Pencil ـویرایش مسیر ـ ترسیم شکل با اشکال آمادهقابل قبول

غیرقابل قبول
عدم توانایی در ترسیم مسیر با ابزار Pen و Pencilـ ویرایش مسیر –ترسیم شکل با 

اشکال آماده
1

ارزشیابی تکوینی مرحله 3
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 كارگاه 4      ترسیم تصاویر برداری از نقش بیتی

Rectangle كارگاه 5     ترسیم نقوش هندسی با استفاده از ابزار 

فیلم  را مشاهده کرده و فعالیت زیر را انجام دهید.

فعاليت 
كارگاهي

یکی از آثار تاریخی شهرتان  را به کمک هنرآموز خود، انتخاب کرده و همانند  تصاویر  نشان داده شده، 
اجرا کنید.

در اين كارگاه می خواهیم روش ترســیم نقوش هندســی 
شکل 7 ـ18 را آموزش دهیم. 

1 یک سند جدید در حالت افقی و در اندازه A4 ایجاد کنید.

2 با استفاده از مسیر نشان داده شده، خطوط شطرنجی 
را فعال کنید.  

    19،کلید میانبر را بنویسید. با توجه به شكل 7 كنجكاوي
Show Grid

شکل 7ـ18

  19ـ فعال کردن خطوط شطرنجی شکل 7

فیلم شماره 10150 : ترسیم تصاویر برداری از تصاویر نقش بیتی فیلم
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3 خطوط محیطی را فعال کرده و مربعی را ترسیم کنید.

 با انتخاب ابزار Rectangle )مستطیل( و کلیک بر روی صفحه، 
پنلی باز می‌شود که می توان با واردکردن اندازه طول و عرض، 

اندازه دلخواه فرم  هندسی را ایجاد نمود. )شکل 7ـ20(

4 با کلیدهای  میانبر Ctrl + C و Ctrl + V یک کپی از 
مربع رسم شده ایجاد کنید. )شکل 7ـ21(

5 مربع کپی شده را بچرخانید.

بــرای چرخش یک فرم هندســی بعد از انتخــاب آن فرم، ابزار 
Rotate را انتخاب کرده و کلیک کنید. ســپس در پنل بازشده، 

زاویه چرخش را وارد کنید. )شکل 7ـ22(

6 با جابه جایی مربع در شکل 7ـ21، شکل 7ـ23 را ایجاد 
کنید.

انتخاب  را  شکل  کرده،  انتخاب  را   Selection 7       ابزار 
پنل  تا  بروید    Window>Pathfinder به مسیر  و  کنید 
را   Add to shape آیکن  حالا  شود،  ظاهر   Pathfinder

برای ترکیب اشکال انتخاب کنید )شکل 7ـ24(.

Rectangle شکل 7ـ20ـ تعیین طول و عرض

) Rotate(شکل 7ـ21ـ انتخاب ابزار چرخش

شکل 7ـ22ـ تعیین زاویه چرخش

شکل 7ـ24ـ پنل Pathficder ـ ترکیب اشکالشکل 7ـ23



183

کار با ابزارهای ساده گرافیکی

8  از تصویر به دست آمده در مرحله 7، کپی گرفته و 
در کنار هم چیدمان کنید )شکل 7ـ25(.

فعاليت 
كارگاهي

 زیرمجموعه ابزار فرم‌های هندسی را باز نموده و با فعال کردن آنها  اشکال جدیدی ترسیم کنید.

 كارگاه 6     طراحی گل با استفاده از فرم دایره

1 یک سند چاپی و در قطع A4 باز کنید.

 fill درحالت   Ellipse (L) ابزار  از  استفاده  با   2
  2  pt ضخامت  به  محیطی  خطوط  و  رنگ  بدون 
کنید)شکل  ترسیم  را  دایره‌ای  دلخواه،  رنگ  و 

7ـ26(.

كنجكاوي مسیر پنل  باز شده شکل 7ـ26 را به همراه کلید میانبر آن در کادر زیر بنویسید.

show Grid

شکل 7ـ 25

شکل 7ـ26ـ تنظیم ویژگی های دایره

 شرایط عملکردمراحل کار
)ابزار،مواد، تجهیزات، زمان، مکان و ...(

نمرهاستاندارد )شاخص ها/داوری/نمره دهی(نتایج ممکن

فضاسازی با 
استفاده از ابزار‌های 

تصویرسازی

مكان: کارگاه استاندارد رايانه
تجهيزات: رایانه ـ سیستم 
عامل ـ نرم افزار گرافیکی

زمان: 30 دقیقه

3بالاتر از انتظار

قابل قبول
انجام عملیات با ابزار Shape Builder ـ  تغییر اندازه،چرخش و ... با ابزارهای 

Transform ـ برش فرم هندسی ـ ترکیب اشکال رسم شده
2

غیرقابل قبول
عدم توانایی در انجام عملیات با ابزار Shape Builder ـ تغییر اندازه، چرخش و ... با 

ابزارهای Transform ـ برش فرم هندسی ـ ترکیب اشکال رسم شده
1

ارزشیابی تکوینی مرحله 4
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4 شکل را انتخاب کرده وسپس به  مسیر Effect > Warp>Arc رفته و تغییرات را طبق پنل بازشده اعمال 
.)28   کنید )شکل 7

.)29           5 سپس مسیر Object > Expand Appearance را اجرا کنید )شکل 7

6  برای چرخاندن گلبرگ، از مسیر Object > Teransform > Rotate در پنل بازشده مقدار زاویه را 
.)30   وارد کنید )شکل 7

7  از گلبرگ کپی گرفته، سپس با فشردن کلید میانبر Ctrl + D گلبرگ‌ها حول نقطه نشان داده شده 
در کنار هم چیده می‌شوند )شکل 7ـ31(.

2ـ3(. 8 نتیجه چنین طرحی است )شکل 7

Warp Options 28ـ پنل   شکل 7

شکل 7ـ29 شکل 7ـ30ـ تعیین اندازه زاویه چرخش شکل 7ـ31ـ کپی گلبرگ

شکل 7ـ32

3 با استفاده از ابزار Direct Selection (A) ابتدا همانند شکل )الف( نقطه پایین دایره را انتخاب 
کرده و تغییر شکل دهید، سپس همانند شکل )ب( نقطه بالای فرم را انتخاب و با راهنمایی هنرآموز 

خود، آن را تغییر دهید )شکل 7ـ27(.

الف ب                                                                

شکل7ـ27ـ تغییر شکل انتخابی
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9 سند را با قالب عمومی )EPS( ذخیره کنید
)شکل 7ـ33(.

EPS (Encapsulated Post Script) یک قالب عمومی 
است که اکثر طراحان هنگامی که می خواهند کار را برای 
از طرح در  یا زمانی که می خواهند  چاپ آماده کنند و 
Indesign و  QuarkXPress )نرم افزارهای  صفحه آرایی( 

خروجی بگیرند، از آن استفاده می‌کنند.
  به مسیر File > Save As بروید و EPS را به عنوان 

file type انتخاب کنید. 

تنظیمات  پنل  انتخاب کنید  را   Save زمانی که کلید 
در  تغییر  بدون  )شکل7ـ33(.  شد  خواهد  باز   EPS

تنظیمات پیش فرض، اطلاعات را Save کنید. 

 Illustrator شاید لازم باشد آن را در یک نسخه پایین تر
ذخیره کنید چون ممکن است فردی که می خواهد از آن 
استفاده کند هنگام باز کردن پرونده با مشکل مواجه شود.

EPS شکل 7ـ33ـ پنل تنظیمات

Version:  اگر می‌خواهید مطمئن باشید که خروجی شما با همه برنامه‌ها سازگار است Illustrator 8.0 را انتخاب کنید. 
نرم افزار دیگر به شما نشان  از طرح در هنگام وارد شدن به یک  یک پیش نمایش سریع   Preview Format

می‌دهد.
Embed Fonts: اگر می خواهید درخروجی EPS فونت های استفاده شده، در طرح قرار گیرد و هنگامی که فرد 

دیگری آن را باز می کند فونت ها در دسترس او باشد، این قسمت را فعال کنید.

فعاليت 
كارگاهي

با استفاده از آموزش داده شده و به کمک هنرآموز خود، تصاویری از گل های جدید ترسیم کنید.

آنچه آموختم:

................................................................................................................................................................................................. .1

.................................................................................................................................................................................................    .2

................................................................................................................................................................................................. .3

برداشت
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 كارگاه 7     ترسیم صفحه گسترده پاکت لوح فشرده 

1 یک سند چاپی باز کنید.
4ـ3، مربعی  در ابعاد  13×13 سانتی متر  2 در صفحه باز شده طبق شکل 7

رسم کنید.

شکل 7ـ34 شکل 7ـ35ـ تنظیمات خصوصیات ترسیم مربع

  35 تنظیم کنید. 3 خصوصیات خطوط مربع رسم شده را طبق شکل 7

Knife شکل 7ـ36ـ ابزار

برای قسمت‌هایی از شکل که قرار است بعد از چاپ تا بخورند از خط چین با درجه وضوح کم استفاده می‌شود. یادداشت

ابزار  با  ابعاد گفته شده در مرحله قبل، ترسیم کرده و  با همان  4 مربع دیگری طبق شکل 7ـ36 و 
Knife )چاقو(، برروی نقطه انتخاب شده کلیک و درگ کرده سپس با فشردن کلید Delete ضلع بالایی 

مربع را حذف کنید.

Delete

شکل 7ـ37

5 نتیجه شکل 7ـ37، خواهد شد.

6  برای قسمت تاشو در پاکت CD مستطیلی در اندازه‌های 13× 2/5 
.)38     سانتی متر رسم کنید)شکل 7
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7 با استفاده از ابزار Direct Selection و با دابل کلیک کردن بر نقاط ضلع بالایی مستطیل آنها را 
انتخاب کرده، با درگ کردن زوایای تند ایجاد کنید )شکل 7ـ39  (.

  Direct Selectionشکل 7ـ39ـ ابزار

8 برای کناره های پاکت، مستطیلی در ابعاد 2×13 سانتی متر ترسیم کرده و مانند مرحله قبل آن را 
0ـ4(. ویرایش کنید )شکل 7

شکل 7ـ41

CD شکل 7ـ38ـ تعیین ابعاد در پاکت

9 به کمک ابزار   ضلع داخلی را برش داده و حذف کنید )شکل 7ـ41(.

شکل 7ـ40ـ تنظیم ابعاد کناره های پاکت

فعاليت 
كارگاهي

10 نتیجه تصویر شکل 7ـ42 است. 

11 سند را ذخیره کنید.

به کمک هنرآموز خود، صفحه گسترده جعبه‌ای را با نرم افزار 
اجرا کنید.

شکل 7ـ42
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ارزشیابی تکوینی مرحله 5
 شرایط عملکردمراحل کار

)ابزار،مواد، تجهیزات، زمان، مکان و ...(
نمرهاستاندارد )شاخص ها/داوری/نمره دهی(نتایج ممکن

گرفتن خروجی 
و ذخیره فایل با 
فرمت های مناسب

مكان: کارگاه استاندارد رايانه
تجهيزات: رایانه ـ سیستم عامل ـ 

نرم افزار گرافیکی
زمان: 7 دقیقه

3بالاتر از حد انتظار

ایجاد خروجی با فرمت های مناسب برای پروژه های چاپی، ویدیویی و وبقابل قبول
2

1عدم توانایی در ایجاد خروجی با فرمت پروژه های چاپی،  ویدیویی و وبغیر قابل قبول

بلی   ارزشيابي کار )شایستگی انجام کار(

   خیر

 معیار شایستگی انجام کار  :
  كسب حداقل نمره 2 از مرحله آماده سازی

  كسب حداقل نمره 2 از بخش شایستگی های غیر فنی , ایمنی, بهداشت , توجهات زیست محیطی و نگرش 
کسب حداقل میانگین 2 از مراحل کار

جدول ارزشیابی نهایی
شرح کار:

1. شناسایی تصاویربرداری و نقش بیتی و نوع نرم افزار گرافیکی
٢. ورود به نرم افزار گرافیکی و آماده سازی سند
3. تصویرسازی با استفاده از ابزارهای ترسیمی

4. فضاسازی با استفاده از ابزار های تصویرسازی
5. گرفتن خروجی 

استاندارد عملکرد: 

با استفاده از دانش و شناخت محيط نرم افزارهاي گرافیکی و چگونگي عملكرد آن، فایل گرافیکی چاپی ایجاد کرده و با استفاده از ابزارهای 
ترسیمی تصویرسازی و فضاسازی کند. فایل را با قالب مناسب ذخیره کند و با گرفتن خروجی مناسب آنها را در سایر پروژه‌ها بکار گیرد.

شاخص‌ها:

شماره 
شاخص‌های مرحله کارمرحله کار

تشخیص تصاویربرداری و نقش بیتی ـ تشخیص نوع نرم افزار گرافیکی1

انجام تنظیمات آماده سازی سند ـ انجام تنظیمات برای ایجاد فایل گرافیکی چاپی ـ ذخیره فایل با فرمت پیش فرض ـ باز کردن فایل تصویری 2
در نرم افزار گرافیکی

انتخاب ابزار Pen و Pencil برای ترسیم مسیر با توجه به کاربرد ـ انتخاب ابزار برای ویرایش مسیر ـ ترسیم شکل با اشکال آماده3

انجام عملیات با ابزار Shape Builder ـ انتخاب ابزار مناسب از مجموعه ابزارهای Transform  برای تغییر اندازه،چرخش و ... ـ برش فرم 4
هندسی ـ ترکیب اشکال رسم شده

ایجاد خروجی با فرمت هایی برای پروژه های چاپی، ویدیویی و وب5
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شرایط انجام کار و ابزار و تجهیزات:
مکان : کارگاه رایانه مطابق استاندارد تجهیزات هنرستان‌ها

تجهیزات :  رایانه ـ سیستم عامل ـ نرم افزار گرافیکی
زمان : 90 دقیقه )شناسایی تصاویربرداری و نقش بیتی و نوع نرم افزار گرافیکی ٥ دقیقه ـ ورود به نرم افزار گرافیکی و آماده سازی 
سند ٨  دقیقه ـ تصویرسازی با استفاده از ابزارهای ترسیمی 30 دقیقه ـ فضاسازی با استفاده از ابزار های تصویرسازی 30 دقیقه ـ 

گرفتن خروجی 7 دقیقه(

مشخصات فنی رایانه :‌
 رایانه که بتواند ویندوز10 و نرم افزار گرافیکی روی آن نصب شود.

معیار شایستگی: 

نمره هنرجوحداقل نمره قبولی از 3 مرحله کارردیف

1شناسایی تصاویربرداری و نقش بیتی و نوع نرم افزار گرافیکی1

1ورود به نرم افزار گرافیکی و آماده سازی سند2

1تصویرسازی با استفاده از ابزارهای ترسیمی3

1فضاسازی با استفاده از ابزار های تصویرسازی4

گرفتن خروجی5

شایستگی‌های غیرفنی، ایمنی، بهداشت، توجهات زیست محیطی و نگرش:

انتخاب فناوری های مناسب)N41( درستکاری و کسب حلال )N73(تصميم گيري )N12( ـ تفكر خلاق 
)N14( ـ نقش در تیم )N53( کارآفرینی )N81( ـ زبان انگلیسی

دانش ارگونومكي )خود فرد( ـ كنترل حفاظتي الكتركيي و الكترونكيي )ابزار و تجهيزات(

ایجاد اسناد الکترونیکی کاهش مصرف کاغذ

امنيت ابزارها و وسايل ـ کاربرد مثال ها و فعالیت هایی در حوزه های اخلاقی، عرفی، دینی و اجتماعی در 
محتوای درسی

2

*میانگین نمرات

*  حداقل میانگین نمرات هنرجو برای قبولی و کسب شایستگی، 2  است.
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واحد یادگیری 8 

شایستگی  كار با ابزارهاي پيشرفته  گرافيكي

آیا تا به حال پی برده اید

• چگونه می توانید طرح خود را به فرمت JPG تبدیل کنید؟

• تصاویر گرافیکی با فرمت JPG کجا کاربرد دارند؟

• چگونه می توان از اشکال دوبعدی، اشکال سه بعدی ایجاد کرد؟

• کاربرد گروه کردن اشکال چیست؟

• استفاده از فونت های فارسی در نرم افزار Illustrator چگونه است؟

هدف از این واحد شایستگی، چگونگي كار با ابزار پیشرفته نرم افزارگرافیکی Illustrator است.

 استاندارد  عملکرد

با استفاده از ابزار پیشرفته محیط نرم افزار گرافیکی، سازماندهی و رنگ آمیزی و جلوه گذاری روی اشیا پروژه، درج 
متن و نمادهای گرافیکی، انتخاب و تنظیمات مد رنگی مناسب برای استفاده در محتوای الکترونیکی، پویانمایی 

)Animation( وگرافیک را براساس دانش فراگيري شده، انجام دهد.
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 كارگاه 1       اجرای لوگوی پرچم جمهوری اسلامی ایران

پرچم جمهوری  وسط  داده شده  نشان  لوگوی   
اسلامی ایران با چه فرمی ترسیم شده است؟

كنجكاوي

در این بخش قصد داریم روش اجرای لوگوی پرچم ایران را با استفاده از برش دایره و چندضلعی ها، آموزش دهیم.

1 یک سند جدید باز کنید.
  Advanced  در پنل بازشده شکل 8ـ1، زیر مجموعه
گزینه‌ای با نام Color Mode  وجود دارد که دارای دو 

مد رنگی  RGB و CMYK است )شکل 8 ـ1(.

مد رنگی : در طبیعت تعدادی رنگ اصلی وجود دارد 
که از ترکیب آنها می توان رنگ های جدیدی ایجاد کرد. 
رنگ‌های رنگین کمان در واقع ترکیبی از رنگ های مختلف 
هستند. انسان نیز همیشه از طبیعت برداشت کرده و همان 
الگوها را در تکنولوژی‌ها استفاده نموده است. اگر کمی 
با رنگ ها و سیستم های دیجیتال کار کرده باشید حتماً 
متوجه شده‌اید که رنگ ها در صفحات وب و نمایشگرها با 
صفحات چاپ شده، اندکی متفاوتند و هر کدام دارای یک 
سری استاندارد و قالب بندی هستند. در این بخش برای 
شما تفاوت دو قالب اصلی رنگ بندی در رایانه به نام‌های 

RGB و CMYK را معرفی می کنیم.

 ،)Yellow(زرد )Magenta(سرخابی ،)Cyan( در این مد رنگی، رنگ‌ها از ترکیب چهار رنگ  آبی فیروزه‌ای :CMYK 
سیاه )Black( به دست می‌آیند. از مد رنگی CMYK برای چاپ بر روی كاغذ استفاده می‌شود.

RGB: در این مد رنگی، رنگ‌ها با ترکیب سه رنگ قرمز )Red(، سبز )Green( و آبی )Blue(  به وجود می‌آیند. با تغییر 
دادن مقدار هریک از این سه رنگ، می‌توان رنگ‌های بسیار زیادی به وجود آورد. این نوع مد رنگی بیشتر برای كارهای 

تلویزیونی و رنگ‌های استاندارد صفحه نمایش استفاده می‌شود  این سیستم رنگ، دارای 16 میلیون رنگ است.

شکل 8ـ1ـ تعیین مد رنگی
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فعاليت 
كارگاهي

در جدول زیر نام رنگ‌های موجود در مدها را به همراه مفهوم آنها بنویسید .

جدول مدهای رنگی

RGBCMYK

با  File/place تصویر لوگوی آماده را وارد کرده و  از مسیر   2
کلیک کردن تصویر را ثابت کنید )شکل 8ـ2(.

3  درجه وضوح تصویر را کم کنید )شکل 8ـ3(.
درجه وضوح يک تصوير رايانه‌اي تعداد پيکسل‌هاي موجود در واحد 
طول )افقي يا عمودی( است. بنابراين در يک طول واحد )مثلًا يک 
اينچ( هرچه تعداد پيکسل‌ها کمتر باشد، درجه وضوح آن کمتر و اندازه 

پيکسل‌ها بزرگ تر است و برعکس. 

4 با انتخاب مسیر Object/Lock/Selection تصویر را بروی صفحه 
قفل کنید.

 با این روش تصویر جابه جا نمی‌شود.

کلید میانبر گزینه Lock را در کادر زیر بنویسید. كنجكاوي
Lock

شکل 8ـ2

شکل 8ـ3ـ تغییر درجه وضوح تصویر

لوگو  تصویر  بر  مماس  بیضی  و  کرده  انتخاب  را  دایره  ابزار   5
ترسیم کنید )شکل 8ـ4(.

شکل 8ـ4
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فعاليت 
کاربرد دو  ابزاری که در مرحله 7معرفی شده را در جدول  بنویسید.كارگاهي

Live Paint Selection ToolLive paint Bucket

با استفاده از ابزار Selection و با کلیک و کشیدن ماوس بر نقاط محیط دایره، می توان آن را تبدیل  به 
بیضی کرد.

یادداشت

6 بیضی دوم را به روش گفته شده، برخطوط محیطی داخلی  لوگو ترسیم 
کنید )شکل 8ـ5(.

7 با استفاده از ابزار Shape Buil der که در شکل نشان داده شده، قسمت مشترک را جدا کنید )شکل 
8ـ6(.

برای جدا کردن قسمت مشترک، بعد از انتخاب ابزار، ماوس را بر فضای مشترک کلیک و درگ کنید. لازم است که هر دو 
ابزار فرم بیضی درحالت انتخاب باشند. هنگامی که تصویر به شکل )8   ـ6  ـ1( در آمد بر روی صفحه کلیک کرده، سپس 
بخش مشترک را با ابزار Selection انتخاب نموده و  از صفحه کلید دکمه Delete را فشار دهید تا شکل )8ـ6ـ2( به 

دست آید.

شکل 8ـ5

Shape Builder شکل 8 ـ6 ـ2شکل 8ـ6ـ1شکل 8ـ6ـ ابزار

کرده،  انتخاب  را  لوگو  از  شده  اجرا  بخش   8
سپس از مسیر Object/Transform/Reflect پنل 

Reflect را فعال کنید )شکل 8ـ7(.
جهت  در  شده  انتخاب  شکل  از  می‌توان  پنل  این  در 

عمودی یا افقی کپی گرفت.
را طبق  تنظیمات   Axis بخش  در  گرفتن  برای کپی 

تصویر وارد کنید.
Reflect شکل 8ـ7ـ پنل



کار با ابزارهای پیشرفته گرافیکی

194

9 به کمک هنرآموز و با استفاده از تصاویر و روش‌های گفته شده در مراحل قبل، نیم دایره داخل لوگو 
را اجرا کنید )شکل 8ـ8(.

1 3 42

 Direct Selection 10 برای اجرای الف در مرکز لوگو، فرم شش ضلعی را انتخاب کرده، سپس با استفاده از ابزار
سه نقطه پایین شش ضلعی  را فعال کرده و با ماوس درگ کنید تا برانتهای الف، مماس شود )شکل 8ـ9(.

1 2 3 5

شکل 8ـ8

شکل 8ـ9

4

11 با  استفاده از ابزار Shape Builder  فضای مشترک را یکی کنید 
)شکل 8ـ10(.

12 فرم تشدید را ترسیم کنید )شکل 8ـ11(.
ابتدا مطابق شکل 1 دایره‌ای رسم کنید، سپس از آن کپی گرفته طوری که بر دایره لوگو مماس باشد. سپس از دو 

دایره رسم شده کپی دیگری گرفته که بر بخش پایینی تشدید، مماس شود.

در مرحله چهارم با استفاده از ابزار Shape Builder فضای مشترک را جدا کنید.

1 2 3 4 5

شکل 8ـ10

شکل 8ـ11ـ مراحل ترسیم تشدید
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13 نتیجه شکل 8ـ12 است. با دابل کلیک کردن، تصویراصلی لوگو از حالت 
قفل خارج می شود. با فشردن کلید  Delete، آن را حذف کنید. 

ـ با استفاده از ابزار انتخاب Selection با کشیدن ماوس همه شکل ترسیم شده را انتخاب کرده و بعد 
با استفاده از دستور )Ctrl+G( شکل را گروه کنید.

ـ این دستور این امکان را به کاربر می‌دهدکه تغییرات و جابه جایی را یکباره بر روی همه شکل ایجاد 
کند.

یادداشت

14 لوگوی اجرا شده را رنگ کنید )شکل 8ـ13(.
ابزار Selection را انتخاب کرده و روی شکلی که ترسیم کردید کلیک کنید تا انتخاب شود. بر روی Fill Color در 

جعبه ابزار کلیک کنید تا پنل نمونه رنگ‌ها آشکار شود. نمونه رنگ مشکی را انتخاب کنید. نتیجه شکل زیر است.

15  سند را با فرمت نرم افزار EPS و Ai ذخیره کنید.

شکل 8ـ12

شکل 8ـ13ـ اعمال رنگ روی لوگو

آنچه آموختم:

................................................................................................................................................................................................. .1

.................................................................................................................................................................................................    .2

................................................................................................................................................................................................. .3

برداشت
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 كارگاه 2      طراحی پرچم جمهوری اسلامی ایران

1  با استفاده از ابزار Rectangle سه مستطیل یک اندازه ترسیم کنید.
 هرکدام از مستطیل‌ها را طبق دستور نشان داده شده در شکل 8ـ14 رنگ آمیزی کنید.

2  سند  لوگوی ایجاد شده درکارگاه قبل را بازکرده و لوگو را انتخاب و سپس در سند  فعلی کپی کنید
)شکل 8ـ15(.

3  شکل به دست آمده را گروه کنید. 

شکل 8ـ15شکل 8ـ14ـ رنگ آمیزی مستطیل

منوی معادل کلید میانبر CTRL+G را داخل کادر بنویسید. كنجكاوي

Ctrl+G

 Object/Envelope Distort /Reset with Warp 4 با انتخاب مسیر
پنل Warp Options را فعال کرده، تنظیمات را اعمال کنید. 

)شکل 8ـ16(

قادر می‌سازد  را  ما  نرم افزار دارای ویژگی Warp Options است که 
یاد  این آموزش  ببریم و همان طور که در  به کار  برای متن  مسیری 
اشکال   و  متن  کردن  منحنی  برای  مسیر  آن  از  می‌توانیم  می‌گیرید، 
استفاده کنیم. در بخش Style می‌توان با استفاده از حالت‌های موجود، 

تغییراتی بر روی شکل ایجادکرد.

Warp شکل 8ـ16ـ تنظیمات
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فعاليت 
كارگاهي

دیگر سبک‌های موجود در پنل Wrap Options را اجرا کنید.

انتخاب مسیر Object/Envelope Distort /Reset with Mesh پنل زیر را فعال کرده، طبق شکل  با   5
تنظیمات را اعمال کنید )شکل 8ـ17(.

6 با انتخاب ابزار  Direct Selection و کلیک کردن بر نقاطی که برروی تصویر ایجاد شده دستگیره‌هایی 
 ـ18(. ایجاد می‌شود که با جابه جایی و حرکت دادن آنها می‌توان تصویر را تغییر فرم داد )شکل 8

شکل 8ـ17

شکل 8ـ18

7 سند را با قالب Ai و  JPG چاپی ذخیره کنید.	

در این مرحله، یاد می‌گیرید که چگونه کار هنری یا طرح خود را تبدیل به 
فرمت JPG کنید تا بتوانید در وب سایت‌ها یا چاپ کردن از آن استفاده کنید.

وقتی قصد دارید پرونده خود را به JPG تبدیل کنید گاهی ممکن است 
متوجه فضاهای اضافی شوید که در اطراف تصویر قرار دارند.  دلیل آن وجود 
تصاویر پنهان شده در زیر ماسک است. برای حل این مشکل، لازم است تا 
یک  Crop Area مشخص کنید تا برای Illustrator تعریف کنید که به 
جای خروجی گرفتن از همه قسمت های تصویر، فقط از فضاهای مشخص 

شده خروجی بگیرد. 

با کشیدن یک کادر در اطراف تصویری که می خواهید خروجی گرفته شود، 
آن را مشخص کنید. کادر را انتخاب کرده و به مسیر

 Object/Artboardes/Fit to Selected Art  بروید )شکل 8  ـ19(.
شکل 8ـ 19
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  JPEG گزینه File type رفته و در قسمت File>Export سپس به مسیر
را انتخاب کنید و دکمه  Save را بزنید. پنجره تنظیمات JPEG  ظاهرخواهد 
شد، بسته به اینکه تصویر را برای وب سایت ذخیره می کنید یا برای چاپ، 

ممکن است لازم باشد تنظیمات و تغییرات شکل 8  ـ20 را اعمال کنید.

ذخیره کردن تصویر برای وب سایت یا نمایش روی صفحه نمایشگر:
کیفیت )Quality(: بین 6 تا 8

  درجه وضوح )Resolution(: برای نمایش و وب سایت ها که نیاز به حجم 
کم و سرعت بالا است از عدد72یا 96 استفاده می‌شود.

ذخیره کردن تصویر برای چاپ:
کیفیت: روی 12 تنظیم شود.

 درجه وضوح: روی High قرار بگیرد.
برای چاپ نیاز است کاربر سند را با بهترین کیفیت و حجم ذخیره کند که عدد 

300 پیشنهاد می‌شود )شکل 8ـ21(.

شکل 8ـ20ـ تنظیمات چاپ

شکل 8ـ21ـ تنظیم ذخیره تصویر برای چاپ

ارزشیابی تکوینی مرحله 1

 شرایط عملکردمراحل کار
)ابزار،مواد، تجهیزات، زمان، مکان و ...(

نمرهاستاندارد )شاخص ها/داوری/نمره دهی(نتایج ممکن

شایستگی‌های غیرفنی
انتخاب فناوری های مناسب)N41( ـ درستکاری و کسب حلال ـ 

)N73( ـ تصميم گيري )N12( ـ تفكر خلاق )N14( ـ نقش در تیم 
توجه به همه مواردقابل قبول)N53( ـ کارآفرینی )N81( ـ زبان انگلیسی

2

دانش ارگونومكي )خود فرد( ـ كنترل حفاظتي الكتركيي و الكترونكيي ایمنی و بهداشت
)ابزار و تجهيزات(ـ

توجهات زیست محیطی
ساخت فایل های گرافیکی برای ساخت انیمیشن، پروزه های وب و 

گرافیک محیطی و جلوگیری از اتود دستی کارها در جهت کاهش دورریز 
توجه به ایمنی و بهداشتغیر قابل قبولکاغذ 

1

امنيت ابزار و وسايل ـ ایجاد خلاقیت و نوآوریـ امانت دارینگرش

تنظیمات مد رنگی
مکان : کارگاه استاندارد رایانه

تجهيزات: رایانه ـ سیستم عامل ـ نرم افزار گرافیکی
زمان: 10 دقیقه

3بالاتر از حد انتظار

قابل قبول
تنظیم مد نمایش یا چاپی برای فایل هاـ 

تغییر درجه وضوح تصویرـ گرفتن 
jpg خروجی

2

عدم توانایی در تنظیم مد نمایش یا چاپی غیر قابل قبول
برای فایل هاـ تغییر درجه وضوح تصویرـ 

jpg گرفتن خروجی

1



کار با ابزارهای پیشرفته گرافیکی

199

1 با فشردن كليد ترکیبی CTRL+N فایل جدید  ايجاد کنید.

R=245,G=128,B=37 .رسم كنيد و طبق این دستورات رنگ را اعمال کنید Ellipse (L( 2 كي بيضي  با ابزار

3 سپس با ابزار Direct Selection فرم بیضی  را به شكل 2 تبدیل کنید
)شکل 8ـ22(.

4 با ابزار مداد )Pencil Tool(N خط هاي افقي روي هويج رسم كنيد و رنگ آنها مطابق اعداد تنظیم 
R=221,G=93,B=5 .کنید

5 براي رسم ساقه گياه هويچ از ابزار مداد با رنگ‌هاي R=141,G=139,B=0 استفاده كنيد و براي تغییر 
ضخامت آن از گزینه Stroke استفاده کنید.

 كارگاه 3     گلدان رشد هویج

دراین کارگاه قصد داریم روش ترسیم گلدان رشد هویج را آموزش دهیم.

Warp/ براي رسم گلدان استفاده كنيد سپس آنرا انتخاب کرده از منوي Rectangle (M(6 از ابزار مستطيل
Bulge /Effect گزینه Bluge را کلیک کنید تا با تغییر فرم به شكل گلدان تبديل شود )شکل 8ـ23(.

شکل 8ـ22
1 2

شکل 8ـ23ـ تنظیمات Warp برای تغییر شکل گلدان 
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6 برای چیدمان هويج‌ها در داخل گلدان، شکل هویج را بر روی گلدان گذاشته درحالت انتخاب راست 
كلكي كرده و گزينه Arrang /Send Backward را انتخاب کنید )شکل 8ـ24(.

 Shift 7 شکل هويج را انتخاب  کرده سپس كليد
را به همراه Alt پايين نگه داشته و آن ‌را به سمت 
تا  فشرده  را   Ctrl+D سپس  كنيد.  منتقل  راست 
كپي صورت گيرد. به همین ترتیب هويج‌ها راكپي 

كنيد )شکل 8ـ25(.

Blend كارگاه 4     طراحی فرم های فضایی با استفاده از افکت 

1 سند جدید باز نموده و با ابزار مداد خطوط1 و2 را 
به دلخواه ترسیم کنید )شکل 8ـ26(.

2 در این مرحله با انتخاب ابزار Selection با درگ 
کردن هردو خط را انتخاب کنید.       

شکل 8ـ24ـ قرار دادن هویج در گلدان

شکل 8ـ25ـ کپی کردن هویج ها

شکل 8ـ26

شکل 8ـ26ـ تعیین تعداد خطوط بین دو خط

 Object/Blend/Blend Options 3 از مسیر
و در قسمت Spacing تعداد خطوط بین خط 
شماره 1 و شماره 2 را طبق شکل 8ـ26  تنظیم 

کرده و Ok کنید.     
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4 با انتخاب مسیر Object/Transform/Reflect پنل Reflect را فعال کنید.

 در بخش Axis با فعال کردن جهت‌های افقی و عمودی، تصویر تغییر موقعیت می‌دهد. در قســمت Angle هم 
می‌توانید زاویه چرخش را تنظیم کنید.

همزمان با تغییر دادن موقعیت شکل گزینه Copy را انتخاب کنید در این حالت از تصویر انتخاب شده کپی گرفته 
می‌شود.

با استفاده از ابزار انتخاب Selection هر دو شکل را انتخاب کرده و با کلید میانبر Ctrl+G شکل را گروه کنید.

کپی در جهت افقی

5 پنل Reflect را فعال کرده این بار تصویر را در جهت عمودی 
کپی کنید )شکل 8ـ27( و با استفاده از ابزار انتخاب، شکل را 

مانند شکل 8ـ28 چیدمان کنید.

شکل 8ـ27ـ کپی تصویر در جهت عمودی شکل 8ـ28

6 تصویر را با انتخاب ابزار ذره بین از جعبه ابزار بزرگ‌تر کرده 
.)29   تا اتصال خطوط با دقت انجام شود )شکل 8

شکل 8ـ29
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0ـ3(. 7 پنل Reflect  را فعال کرده این بار تصویر را در جهت افقی کپی کنید)شکل 8

 ـ      31(. 8 بر روی شکل با استفاده از ابزار فرم های هندسی، مستطیلی ترسیم کرده و با رنگ آبی پرکنید )شکل 8
 Send to Back کلیک کنید. از زیر منوی باز شده گزینه Arrange بر روی مستطیل آبی راست کلیک کرده و روی گزینه

را انتخاب کرده تا مستطیل به لایه پشتی منتقل شود.

9 همه خطوط را انتخاب کرده و از پالت جعبه رنگ Stroke  را کلیک کنید تا پنل رنگ باز شود. خطوط 
2ـ3(. را با درج حروف FFFFFF# به رنگ سفید در بیاورید )شکل 8

شکل 8ـ31شکل 8ـ30

شکل 8ـ32ـ تغییر رنگ خطوط

10 در انتها سند را با قالب نرم افزار ذخیره کنید.
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Mesh كارگاه 5     ترسیم میوه با ابزار 

فعاليت 
كارگاهي

با توجه به آموزش کارگاه 4،  فرم های فضایی جدید  ایجاد کنید .

در اين آموزش قصد داریم با استفاده از ابزار مش  Mesh  و اسپري رنگ )سمپاشي(  ترسیم گلابی را داشته باشیم.

1 ابتدا كي صفحه با اندازه 800در 600 پكيسل  و مد رنگی CMYK باز كنيد. 

2 با ابزار مداد Pen Tool (P) شكل 8ـ33 را رسم كنيد. 

3 برای نرم کردن خطوط محیطی از مسیر Effect/Stylize/Round Corners پنل را اجراکرده و عدد 30 را 
براي شعاع وارد كنيد  )شکل 8ـ34(.

شکل 8ـ34ـ تعیین شعاعشکل 8ـ33

ارزشیابی تکوینی مرحله 2

 شرایط عملکردمراحل کار
)ابزار،مواد، تجهیزات، زمان، مکان و ...(

نمرهاستاندارد )شاخص ها/داوری/نمره دهی(نتایج ممکن

سازماندهی اشیاء 
پروژه

مكان: کارگاه استاندارد رايانه
تجهيزات: رایانه ـ سیستم عامل ـ 

نرم افزار گرافیکی
زمان: 35 دقیقه

3بالاتر از حد انتظار

,Appearance, Map Are قابل قبول پنل  با  عملیات  انجام  ـ  پروژه  سازماندهی 
Symbol

2

عدم توانایی در سازماندهی پروژه -غیر قابل قبول
Appearance, Map Are, Symbol  انجام عملیات با پنل 

1
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5 با استفاده از ابزار Direct Selection  روي شكل کلیک کنید. دستگیره‌های هر نقطه‌ای که برروی 
تبديل شوند  منحنی  به شكل  تا  كرده  تنظيم  را  محیطی  فعال می‌شود. خطوط  می‌کنید  کلیک  آن 

)شکل   8ـ36(.
K=12 و Y=100 و M=35 و C=50                                .)376 رنگ را تنظیم کنید )شکل 8ـ

كلكي  برروي شكل  و  کرده  انتخاب  را   Mesh (U) ابزار مش   7
.)38   كنيد)شکل 8

یکی از ابزارهای شگفت انگیز Illustrator ابزار Mesh است. این ابزار 
برای ساختن اجسام سه بعدی که به صورت دو بعدی طراحی شده‌اند 

بسیار کاربرد دارد.
 شما می توانید با Mesh Points یا نقاط مش، رنگ‌های جدید را بر همان 
 Direct Selection نقطه انتخاب شده اعمال کنید و با استفاده از ابزار
ویرایش کنید تا کنترل بیشتری روی شکل و فرم شیء Mesh داشته 

باشید.
Mesh Line خطوط تراز شکل را نشان می‌دهند.	

                                                                                Mesh Line

                                                                                Mesh Points

شکل 8ـ37ـ تنظیم رنگشکل 8ـ36

Mesh شکل 8ـ38ـ ابزار

کلیک  با  کنید.  باز  را  پنل   Window/ Appearance از مسیر  ترسیم شده،  اشکال  ویرایش  برای   4
.)35     کردن روی هرگزینه می‌توان پنل مربوطه را فعال کرد )شکل 8

Appearance شکل 8ـ35ـ فعال کردن پنل های
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8 با گره‌هايي كه در اختيار شما قرار داده شده است می‌توانید رنگ هرنقطه‌اي كه مايل هستيد را تغيير 
9ـ3(. دهيد. با ابزار Direct Selection  اين كار میسر است)شکل 8

برای نشــان دادن فرو رفتگی‌ها، از رنگ‌های تیره و برای نشان دادن برآمدگی‌ها از رنگ‌های روشن 
استفاده کنید.

یادداشت

 C=35 M=70 Y=100  K=30 9 برای ترسیم دم برگ ميوه  طبق شکل 8ـ40 پیش روید و رنگ آن را به
تنظیم کنید.

10 براي کامل‌تر شدن شکل میوه، كي برگ هم اضافه كنيد مراحل را مطابق شكل 8ـ41 انجام داده  و 
با کمک ابزار Mesh درآن سایه روشن ایجاد کنید. 

شکل 8ـ39ـ تغییر رنگ نقاط تعیین شده

شکل 8ـ40

شکل 8ـ41
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11 بــا گزينــه Object/ Arrange/ Send BackWard  و يا با 
فشــاردادن دو كليد ]+Ctrl شكل برگ را به پشت شکل میوه 

2ـ4(. انتقال دهید )شکل 8

 C=46 , M=47 , با رنگ‌هاي  Ellipse 12  بــراي  ایجاد نقطه‌هاي روي گلابي، ابتدا كي دايره كوچك با ابزار
Y=67 , K=18 ترســیم كنيد و رنگ طيف آن ‌را از مسیر  Window / Transparency   به 40 درصد تغيير 

دهيد )شکل 8ـ43(.

4ـ4(. 13  اين دايره كوچك را تبديل به Symbols كنيد )شکل 8
از مسیر Windows / Symbols پنل را فعال کرده سپس دایره کوچک 
رنگی را به پنل Symbol درگ کنید تا تصویر درگ شــده به عنوان یک 

نشانه ذخیره ‌شود.

14 اسپري رنگSprayer (Shift + S) را از جعبه ابزار انتخاب کرده و بروی  گلابي کلیک کنید )شکل 
.)45       8

شکل 8ـ42ـ انتقال برگ به پشت میوه

شکل 8ـ43

شکل 8ـ44

شکل 8ـ45ـ اعمال رنگ

15 براي سايه زير ميوه هم كي بيضي با طيف رنگي ترسيم كنيد تا در نهايت شكل 8ـ46 به وجود بيايد.

شکل 8ـ46ـ ایجاد سایه
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  تصویر را ترسیم کنید.

3D كارگاه 6     طراحی قوطی با ابزار 

1 سند جدیدی باز کرده و با ابزار Pen تصویری شبیه شکل 
8ـ47 ترسیم کنید.

در این کارگاه  می خواهیم روش طراحی اشکال سه بعدی را آموزش دهیم.

2 شکل ترسیم شده را انتخاب کرده و  از مسیر
.)48    Effect/3D/Revolve پنل را اجرا کنید )شکل 8  

شکل 8ـ47

شکل 8ـ48

فعاليت 
كارگاهي

 شرایط عملکردمرا حل کار
)ابزار،مواد، تجهیزات، زمان، مکان و ...(

نمرهاستاندارد )شاخص ها/داوری/نمره دهی(نتایج ممکن

رنگ آمیزی اشیاء

مكان: کارگاه استاندارد رايانه
تجهيزات: رایانه ـ سیستم عامل ـ 

نرم افزار گرافیکی
 زمان: 10 دقیقه

3بالاتر از انتظار

انجام عملیات با پنل های رنگ و رنگ آمیزی اشیا به روش های مختلف ـ رنگ آمیزی قابل قبول
اشکال با ابزار Mesh ـ استفاده از ابزارهای رنگ آمیزی دوبعدی و سه بعدی

2

غیرقابل قبول
عدم توانایی در انجام عملیات با پنل های رنگ و رنگ آمیزی اشیاء به روش های مختلف ـ 
رنگ آمیزی اشکال با ابزار Mesh ـ استفاده از ابزارهای رنگ آمیزی دوبعدی و سه بعدی

1

ارزشیابی تکوینی مرحله 3
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 ـ48 تنظیمات را واردکرده و کلید ok را انتخاب  3 طبق شکل 8
کرده تا شکل 8ـ49 بدست آید.

4 با استفاده از گزینه place تصویری را که قصد دارید به عنوان برچسب روی شکل قرار گیرد وارد کنید.

 در 

24

 
 

 
 3Dطراحی قوطی با ابزار 

 
 بعدي را آموزش  دهیم . 3دراین کارگاه  قصدداریم روش طراحی اشکال 

 ترسیم کنید. 1تصویري شبیه شکل  Penسند جدیدي باز کرده و با ابزار -1
 
 اجرا کنید.را  2 پنل شماره  Effect/3D/Revolveشکل ترسیم شده را انتخاب کرده و  ازمنوي -2
 
 بدست آید. 3شکل کرده تا را انتخاب  okتنظیمات را واردکرده و کلید  2طبق تصویر شماره  -3
 
 تصویري را که قصد دارید به عنوان برچسب بر روي شکل قرار گیرد وارد کنید. placeبا استفاده از گزینه  -4
 

نوارخصوصیات  در گزینه برروي  اگر تصویري که به عنوان برچسب در نظر دارید فایل نقش بیتی باشد  -5
 تعریف کرد. symbolsتوان به عنوان یک کلیک کنید. به این ترتیب تصویر را می

 
 را فعال کنید. symbolپنل  -6

 6کارگاه 

5 اگر تصویری که به عنوان برچسب در نظر دارید پرونده نقش بیتی باشد روی گزینه 
نوار خصوصیات کلیک کنید. به این ترتیب تصویر را می‌توان به عنوان یک Symbol تعریف کرد.

0ـ5(. 6 پنل Symbols را فعال کنید )شکل 8

1ـ5(. 7 تصویر را به پنل Symbols درگ کنید  )شکل 8

شکل 8ـ49

شکل 8ـ51

8 از مسیر Window/Appearance طبق شکل 8ـ52 پنل را فعال کنید.
در پنل باز شده با دابل کلیک کردن افکت 3D Revolve را فعال کنید.

9 در پنل باز شــده گزینه Map Art را کلیک کنید تا 
شکل 8ـ53 اجرا شود.

شکل 8ـ52

شکل 8ـ53
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کرده  انتخاب  را  شده  وارد  برچسب   Symbols قسمت  در   10
و عدد گزینه surface را تنظیم کرده و گزینه Scale to fit را 

کلیک و کلید ok را فشار دهیدتا شکل 8ـ54 به دست آید.

11 سند را ذخیره کنید.

شکل 8ـ54

 كارگاه 7     نقاشی سه بعدی

پس از مشاهده فیلم، تصویر زیر را ترسیم کنید.

 شرایط عملکردمرا حل کار
)ابزار،مواد، تجهیزات، زمان، مکان و ...(

نمرهاستاندارد )شاخص ها/داوری/نمره دهی(نتایج ممکن

جلوه گذاری بر 
روی اشیاء

مكان: کارگاه استاندارد رايانه
تجهيزات: رایانه ـ سیستم 

عامل ـ نرم افزار گرافیکی
زمان: 15 دقیقه

3بالاتر از انتظار

2جلوه گذاری ـ ایجاد اشکال سه بعدی با ابزار 3Dـ استفاده از پنل نمادهاقابل قبول

عدم توانایی در جلوه گذاری ـ ایجاد اشکال سه بعدی با ابزار 3D ـ استفاده از پنل نمادهاغیرقابل قبول
1

ارزشیابی تکوینی مرحله 4

آنچه آموختم:

................................................................................................................................................................................................. .1

...................................................................................................................................................................................................2

................................................................................................................................................................................................. .3

برداشت

فیلم شماره 10151: ترسیم نقاشی سه بعدیفیلم
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Illustrator كارگاه 8     فارسی نویسی در نرم افزار 

پس از مشاهده فیلم، فعالیت زیر را انجام دهید.

فعاليت 
كارگاهي

 با استفاده از فونت های فارسی، تابلویی را برای سردر کارگاه یا مدرسه خود طراحی کنید.

آنچه آموختم:

................................................................................................................................................................................................. .1

...................................................................................................................................................................................................2

................................................................................................................................................................................................. .3

برداشت

ارزشیابی تکوینی مرحله 5
 شرایط عملکردمراحل کار

)ابزار،مواد، تجهیزات، زمان، مکان و ...(
نمرهاستاندارد )شاخص ها/داوری/نمره دهی(نتایج ممکن

استفاده از متن در 
فایل گرافیکی

مكان: کارگاه استاندارد رايانه
تجهيزات: رایانه ـ سیستم عامل ـ 

نرم افزار گرافیکی ـ نرم افزار فارسی ساز
زمان: 20 دقیقه

3بالاتر از حد انتظار

ایجاد قابل قبول ـ   Type Tool عملیات  انجام  ـ  فارسی  فونت های  از  استفاده 
متون هنری و پاراگرافی ـ انجام عملیات با پنل های تنظیمی متون

2

غیر قابل قبول
 Type انجام عملیات  از فونت های فارسی ـ  توانایی در استفاده  عدم 
پنل های  با  عملیات  انجام  ـ  پاراگرافی  و  هنری  متون  ایجاد  Toolـ 

تنظیمی متون

1

بلی   ارزشيابي کار )شایستگی انجام کار(

   خیر

 معیار شایستگی انجام کار:
  كسب حداقل نمره 2 از مرحله آماده سازی

  كسب حداقل نمره 2 از بخش شایستگی های غیر فنی , ایمنی, بهداشت، توجهات زیست محیطی و نگرش 
کسب حداقل میانگین 2 از مراحل کار

فیلم شماره 10152: فارسی نویسی در نرم افزار Illustratorفیلم
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شاخص‌ها:

شماره 
شاخص‌های مرحله کارمرحله کار

1jpg انتخاب تنظیمات برای مد نمایش یا چاپی سند ـ انتخاب درجه وضوح مناسب برای تصویر ـ گرفتن خروجی

2Appearance, Map Are, Symbol  انجام عملیات با پنل

انجام عملیات با پنل های رنگ و رنگ آمیزی اشیاء به روش های مختلف ـ رنگ آمیزی اشکال با ابزار Mesh ـ  استفاده از  ابزارهای رنگ آمیزی 3
دو بعدی و سه بعدی ترکیب اشکال رسم شده

43D جلوه گذاری روی اشیا ـ استفاده از پنل نمادها ـ ایجاد اشکال با ابزار

استفاده از فونت های فارسی ـ انجام عملیات با Type tool ـ ایجاد متون هنری و پارگرافی ـ انجام عملیات با پنل های تنظیمی متون5

شرایط انجام کار و ابزار و تجهیزات:
مکان : کارگاه رایانه مطابق استاندارد تجهیزات هنرستان‌ها

تجهیزات :  رایانه ـ سیستم عامل ـ نرم افزار فارسی ساز ـ نرم افزارگرافیکی
زمان : 90 دقیقه  )تنظیمات مد رنگی 10 دقیقه ـ سازماندهی اشیاء پروژه 35 دقیقه ـ رنگ آمیزی اشیا 10 دقیقه ـ  جلوه گذاری بر 

روی اشیاء 15 دقیقه ـ استفاده از متن در فایل گرافیکی20 دقیقه(

مشخصات فنی رایانه :‌
 رایانه که بتواند ویندوز10 و نرم افزار گرافیکی روی آن نصب شود.

جدول ارزشیابی نهایی

شرح کار:
1.تنظیمات مد رنگی  

2. سازماندهی اشیاء پروژه
3. رنگ آمیزی اشیا

4. جلوه گذاری بر روی اشیاء
5. استفاده از متن در فایل گرافیکی

 

استاندارد عملکرد: 

با استفاده از ابزارهای پیشرفته محیط نرم افزار گرافیکی، سازماندهی و رنگ آمیزی و جلوه گذاری روی اشیا پروژه، درج متن و 
نمادهای گرافیکی، انتخاب و تنظیمات مد رنگی مناسب برای استفاده در محتوای الکترونیکی، انیمیشن وگرافیک را براساس دانش 

فراگيري شده انجام دهد.
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معیار شایستگی: 

نمره هنرجوحداقل نمره قبولی از 3 مرحله کارردیف

1تنظیمات مد رنگی1

1سازماندهی اشیاء پروژه2

1رنگ آمیزی اشیا3

1جلوه گذاری بر روی اشیاء4

1استفاده از متن در فایل گرافیکی5

شایستگی‌های غیرفنی، ایمنی، بهداشت، توجهات زیست محیطی و نگرش:

انتخاب فناوری های مناسب)N41( ـ درستکاری و کسب حلال ـ )N73( ـ تصميم گيري )N12( – تفكر 
خلاق )N14( ـ نقش در تیم )N53( ـ کارآفرینی )N81( ـ زبان انگلیسی

دانش ارگونومكي )خود فرد( ـ كنترل حفاظتي الكتركيي و الكترونكيي )ابزار و تجهيزات(

ساخت فایل های گرافیکی برای ساخت انیمیشن، پروزه های وب و گرافیک محیطی و جلوگیری از اتود 
دستی کارها در جهت  کاهش دور ریز کاغذ

امنيت ابزار و وسايل ـ ایجاد خلاقیت و نوآوریـ امانت داری

2

*میانگین نمرات

*  حداقل میانگین نمرات هنرجو برای قبولی و کسب شایستگی، 2  است.




